
TIPS AND TRICKS
Tips and tricks for using many of Extreme 3D’s features are contained in the following 
topic sections: Modeling, Animating, Lighting and Materials, Rendering, Performance, 
and General Tips. Choose the topic you are interested in. Also, be sure to check  
Macromedia’s web page Tech support topic for daily updates to tips and tricks  and for 
illustrated tips and tricks.
<p>
<2> MODELING

<3> MODELING TOOLS

Center Arc Tool

The center arc tool can be used to measure angles between three points. Read the 
values from the tool space 

Line Tool

MEASURE THE distance between any two points by 3D-snapping a line between them 
and watching its length in the tool field. To find a point midway between two other 
points, 3D-snap a line between them, then scale this line to 50% in the Object browser.

EXTEND A line along a vector by controlling its length in the Object browser. 
<p>
Move Object Center Tool

THE OBJECT'S center point defines an object's center of rotation and scale and the 
origin of scale for scaling groups of control points on an object. The center point also 
defines the position of a customized material. (Orientation and scale of the material are 
defined by the material placement and orientation tools.) Finally, the object’s center 
point also affects how certain deformations operate.

VERTEX EDITING sometimes produces more of a spiny look than is appropriate for 
your object. If so, try moving the object’s center close to a group of polygon vertices, 
select those vertices and scale them. Then move the object center back to its original 
position. This will produce a smoother surface. Points nearest the object’s center scale 
least.

AN OPTION to moving the object center is to lock link the object to a construction axis 
at the desired location. Although the Move Object Center Tool can be used to change 
center of rotation,  this technique is less destructive 
<p>
Deformation Tools

ALL DEFORMATIONS are, by default, limited to the extent of the object. You can 
change this area of influence to greater than or less than the object’s extents - by 
pressing the Alt (Windows) or Option (Macintosh) key and clicking or dragging 
deformation boundaries on part of an object.



SWEPT OBJECTS are sometimes better created along straight lines and then 
deformed. Because all deformations need intermediate control points, sweeping the 
profiles along a straight line and increasing the number of sections before simplifying 
allows deformations of swept objects to function as expected.

UNIFORM SMOOTHING can be used to change the subdivisions of an object being 
bent with bend tool. Increase the row or column values in the areas where the object 
bends the most.
<p>
MULTIPLE OBJECTS can be deformed. To demonstrate multi-object bending, create 
three rectangles in a horizontal row.  (For descriptive purposes we'll call these 
rectangles Left Arm, Torso,  and Right Arm.) Select all of them. Double-click  the bend 
tool to open its preferences dialog box.  Set the  bend axis to X and click OK.  Select the
bend tool. Use Option-click (Macintosh) or F3-click (Windows)  to set the beginning of 
the bend. This can be at the left edge of the left arm.   Click the end of the bend  past 
the right of the Right Arm.
Drag the mouse and all three objects will bend as one object. All objects in a multiple 
object deformation use the same axis.

Fillet Tool

You can use the fillet tool on multiple profiles. For example, if you draw a line through 
the center of a circle/ellipse you can use the fillet tool to fillet the ellipse and the line 
(click once on line, once on ellipse). The fillet creates an arc with the radius  specified in
the tool space wherever it intersects both points.
<p>
Intersection Tool

END CAPS must first  be separated from end-capped objects before you attempt object 
intersections with them. After end caps are separated, the object becomes three 
objects: the main body and two end caps. Perform the intersection on each of these 
three objects separately.  For another suggestion, see the cross section tip below. 

CROSS SECTION objects do not have end caps. Therefore, using the cross section 
tool to create objects such as cylinders or cubes simplifies performing intersection and 
trim operations on these kinds of objects.
<p>
Skin Tool

Although splines provide definition for the skinned object, depending on the 
arrangement of control points,  the splines do not necessarily fully enclose the final skin.
For some kinds of objects this can offer great flexibility in manipulating skinned shapes. 
Edit control point locations and their spline handles after the skin is created to 
experiment with different shapes.
<p>
<3> MODELING COMMANDS



Fit Polylines 

This command is most useful if you have  many points along a polyline and wish to find 
the most efficient curve which approximates them. It is also useful for making imported 
2D DXF files more efficient. 

Join Profiles 

For detail work, it is useful to zoom in on the profiles to be joined and snap objects to 
each other before joining them. 

Align 

The align command aligns objects with the position and/or orientation of its parent. 
Creating a “dummy parent object” by linking objects to be aligned to a construction point
or axis is a quick way to align multiple objects.
<p>
Smooth Polyline 

You can smooth the corners of a rectangle by converting the rectangle into polylines. 
First use the Simplify Geometry command; then choose Smooth Polyline.
<p>
ANIMATING

This topic covers tips and tricks for using specific animation commands and procedures.
<p>
Animating Links

Links cannot be animated. That is, an object cannot change its parent over time. 
However, you can link to parent A, submit those frames to the render queue, then link to
parent B and submit those frames to queue before finally entering render mode, in order
to give exactly the same effect.

Watch Links

To change the axis along which an object looks at a target, lock link the object to a 
construction axis which watches the target, and change object’s orientation in the 
Objects browser.

Align Camera To View

This command is useful for setting up a series of establishing shots and  then having 
the camera animate among them. Edit the resulting path in score by establishing key 
frames at critical  points to control the camera's interpolation.
<p>
Inheriting Tracks From Parent Objects



Child objects can inherit  position, orientation, and scale tracks from the parent.  For all 
other tracks, children receive copies of the parent's track when the track is changed and
applied downtree. For example, when the "Deform Down Tree" option is used  and the 
parent is  deformed,  the children get a deformation track as well.   Compare this to 
changes in the  parent's and child's  position, orientation, and scale tracks, where 
children do not get tracks when these tracks change for the parent.
<p>
Free-Form Deformation Animation

EVERY DEFORMATION operation creates another track.  To animate a single 
deformation, add key frames to an existing deformation track in the score and editing 
the deformation value in the text entry field.

DEFORMS DONE at time zero are permanent.  This is very important when animating 
deformations, particularly of linked objects.  Anything done at time zero changes the 
actual shape of the object.   One work around, if this is not your desired behavior, is to 
set the first deformation at a frame other than zero, say  10 and start your render at  
frame 10.  Another work around is to model and animate the deformations with parent 
objects then duplicate with links to make the child objects.  The animation data is copied
as well. Yet another work around is to animate one object and then copy and paste 
tracks, one at a time, into the other objects.
<p>
Dynamic Animation Using ASCII Files

DYNAMIC OR physically accurate animation, such as animated explosions,  fountains, 
or swarms of many objects may be accomplished in Extreme 3D by creating motion 
data with another animation source and importing it as an ASCII text file. Possible 
animation generation sources include applications such as Macromedia Director or 
Swivel 3D that have their own scripting languages, standard programming languages 
such as C or C++, or polhemus or other motion capture devices. Extreme 3D does not 
provide a conversion utility for animation data generated from one of these sources. You
must convert your animation data into the ASCII text file format specified below  before 
it can be imported into Extreme 3D.
<p>
EXTREME 3D recognizes position and orientation data for objects. Position data must 
be written as discrete x, y and z values. Orientation data must be written as quaternion 
rotations. Extreme 3D also recognizes two types of sampling rates— uniform and non-
uniform. Uniform sampling evenly distributes the motion data events along the track, 
assigning each one a key frame in the score. Non-uniform sampling distributes the 
motion data events along the track at the times you designate, assigning each one a 
key frame in the score. The sampling rate you choose depends, in part, on the method 
you use to generate your motion data and, in part, on the animation effect you wish to 
achieve. When you import Extreme 3D  tracks you are actually importing E3D animation
information that has been translated into this ASCII format.    



<p>
UNIFORM ASCII tracks follow the form:

track
objName;trackName
uniform  startTime   stopTime
%g %g %g...
endTrack

TRACK AND endTrack lines define the limits of one track in the ASCII file. 
The objName argument is the name of the Extreme 3D object to which this track will be 
assigned when the ASCII file is imported.  The trackName argument should be either 
position or orientation.

UNIFORM MUST be the first word in the next line. This word must be followed by two 
numbers that define the starting and ending times for the track. 
Each line of data that follows represents one key frame and must have the exact 
number of values appropriate for that track. For example, position must have 3 values; 
orientation must have 4 values. 
<p>
NON-UNIFORM ASCII tracks follow the form:

track
objName;trackName
nonuniform 
time %g %g %g...
endTrack

THE STRUCTURE of the first two lines and the last line are exactly the same for a non-
uniform track as they are for a uniform one. The first word in the third line must be non-
uniform. The time for the key frame is specified by the first value on the next line. The 
remaining values on that line are interpreted as the position or orientation values for that
key frame. Each line of data that follows represents one key frame, the time for that key 
frame always being specified by the first value in the line. As with uniform tracks, each 
line must have the exact number of values appropriate for that track. Position must have
3 values; orientation must have 4 values.
<p>
BEFORE AN ASCII text file can be imported into Extreme 3D, each object name in the 
ASCII file must match an object of the same name in the .E3D file.  Data whose object 
names do not match the name of Extreme 3D objects will not be imported. To import 
ASCII file animation data for a single object, either select the object in the workspace or 
its position or orientation track in the score. Choose  Import  from the File menu and 
then choose Extreme 3D tracks. 
To import  data for multiple objects, select the objects in workspace. In both cases, 
when the file is imported, Extreme 3D adds key frames to the selected objects’ 
appropriate tracks that correspond to the motion data in the file.
<p>
Using 3D Script Files



Another source of dynamic animation data that may be imported into in Extreme 3D is 
Macromind 3D or other applications, like Working Model, that output 3D scripts. These 
files do not need to be converted into ASCII text files for use in Extreme 3D.  As with 
ASCII text files, however, each object name in the 3D Script file must match an object of
the same name in the .E3D file.
<p>
LIGHTING AND MATERIALS

This topic covers tips and tricks for using specific lighting and materials commands and 
procedures. 
<p>
Mondo Maps

You can  achieve very subtle or complex shadowing effects, at little extra cost in 
rendering time, through use of Ambient, Diffuse, and/or Specular maps in the Mondo 
Map default material. Doing a quick render of the scene looking directly down on a floor 
produces a guide for painting in the lighter and darker areas.

Fog Depth

To determine this value so that a particular object is at the 50% point, go into an 
appropriate view where you can see both camera and object, and either estimate by 
looking at the camera’s “distance” line, or 3D-snap an actual line between camera and 
object, noting its length in the tool field.

Ambient Color

Each object’s reaction to this color can be animated quickly by copying and pasting 
tracks in the score. 
<p>
Set Background

The background you choose from Set Background is  rendered into the background at 
final render.  Customizing  bit maps by tracing them may give you a better quality 
background pictures for some animated projects. To take advantage of  zooming while 
tracing, use Macromedia FreeHand to trace curves .

Opacity

If an object is at zero opacity,  you can speed rendering by making it invisible in  Object 
browser.
<p>
Chrome + Glass

TO VARY the intensity of a reflection,  offset  the object a small amount to create  an 
"envelope" Make the outer object reflective and partly transparent, and assign the inner 
object a surface color. Reflections require curved surfaces to 



be sensible. Flat surfaces don;t look as realistic, because  this material uses the surface
normal to reference the map -- if normal does not change, then neither does the 
reflection. 

THE PART of a reflection map shown at a point on a surface depends on camera 
orientation to world and the surface normal. Use material orientation tool to adjust 
where the reflection occurs. On flying logo text, for example, rotating the object will not 
affect the position of the environment map in the reflection. 
<p>
Organic Magic

THE TWO colors need not differ...sometimes just variance in the reflective properties is 
enough. You can achieve a nice effect from changes in roughness parameters. 
Changes in opacity, with smooth complex blending, produces clouds. Edge blending 
makes a snaky pattern at proportions of 50%. The first color is used in the blending area
between the two patterns while the second color fills the body of both patterns.

Plastic

SET SPECULAR and Roughness colors to the surface color, to get good metals. 

SET DIFFUSE value to zero and the ambient value to one, to create  flat, cartoon-style 
surfaces. Turn Specular and Roughness colors to black and make global ambient color 
lighter.
<p>
Tiles

OVERLAY a grid upon an object, even an object which changes shape. by duplicating 
the object and  scaling it up by 1% or offsetting it, and applying a grid with one purely 
transparent element. Changing shapes are particularly effective with a grid that is 
surface-mapped.

WIREMESH MATERIAL can be created with the Tiles Material by using a grid pattern  
at a  small scale and making one color transparent. Because the edges of patterns are 
anti-aliased, they can be used as a high quality wireframe.
<p>
Negative Lights

Dark lights or negative lights are useful for subtle shadows, penumbras, the gentle 
darkness in the corner of a room.  Fuzziness of a spotlight cone determines penumbra. 
Spotlights  with falloff can create a gentle darkness in the corners of a room. A dark light
with a white or gray color to the light is  most predictable, but a dark light of the same 
hue as the regular light results in Maxfield Parrish-like lights of complimentary color. All 
lights can have negative values.



Lights And View Or Camera Perspective

Omni lights and spotlights do not render as expected in orthographic perspective. Use 
any other perspective before doing a final render or final render to screen.
<p>
Alpha Channel Maps For Lights

Spotlights and omni lights do not produce alpha channels because they are 3D light 
effects, not 2D surfaces. However, you can create alpha channel maps for lights by 
rendering stills using the lights for which you want alpha channel maps Creating alpha 
channel  masking maps based on the luminance of the lights in Photoshop or another 
image processing program and composite these images with the rendered stills of the 
image minus the lights.
<p>
RENDERING
This topic covers tips and tricks for using specific rendering commands and procedures.
<p>
Rendering Animations

For predictable final rendering of an animation, it is best to always render from a window
displaying the view through the camera. 

Motion Blur

Motion blur can be simulated in post-processing by rendering your scenes in layers, and
then compositing these layers, offset a frame each in time. Blur the with the rearward 
ones  in compositing  (optionally in direction of motion) and optionally faded to give a 
simulation of camera-based motion blur. You can do this in Adobe Premiere or another 
digital compositor/video editor. By rendering at  sub sampled times (rendering at 60 or 
120 fps) and compositing four frames into one (at 25% contribution for each) 'blur' will 
be lengthened for fast moving objects and in the appropriate direction (per object). 
<p>
Smoothness Settings

Final smoothness for both Adaptive and Uniform Smoothing is related to scale of object 
-- if something has been dramatically resized you may wish to tweak its smoothness 
before rendering.

Output To Video

Temporally over sampling when you render works well for outputting to video. For 
example, output at 60 frames per second. Then interlace these frames as fields at 30 
frames per second in Premiere or another compositing/editing tool.
<p>
PERFORMANCE



This topic contains tips for optimizing Extreme 3D’s performance.
<p>
Creating A Library

Cutting and pasting objects to temporary files is an excellent way to reduce display time,
experiment with a copy of a model in a new file, build a complex scene, or create a 
library of objects, views or camera views which you can copy into other scenes. To 
create a library, open a new Extreme 3D scene and name it “library.” Then when you 
create objects, views or camera views that you might want to use again, copy them into 
the library. When you want to use the item in another scene, copy it from the library. To 
avoid time-consuming screen redraws, keep the library scene small and copy and paste
items between browsers. Also, see the topic Grouping Techniques under GENERAL 
TIPS. 
<p>
GENERAL TIPS

This topic contains tips about Extreme 3D Preferences, file organization and other 
issues of general interest.
<p>
Directory Structure

The E3D directory contains: Scripts, Help,  Presets and, by default, any scene files you 
create.

SCRIPTS CONTAINS the default.E3D file, the preferences file, a file called material and
a file called Extension. The folder/directory called Material inside Scripts contains lights 
that are cataloged (.LIT files), materials that are cataloged (MAT files), and texture maps
(TEX files)

HELP CONTAINS help

PRESETS CONTAIN Folders/directories that contain over 200 preset materials
<p>
Grouping Techniques

Grouping is supported in E3D through layers (see Using Extreme 3D), hierarchies, 
naming and materials.

-- Naming. Name objects that you want to select as group with a consistent leading 
name or group of letters, Chair or AA for example. Use Find with Add to Selection to 
select that group of objects.

-- Hierarchies. Linked objects can be shown, hidden and manipulated as a group for a 
number of procedures. Operations which go down tree include applying materials with 
the bucket tool. scaling and offsetting animation tracks,  and deforming objects with the 
deformation tools. 

-- Materials. When pasting an object from one scene to another,  add a material of 
default plastic type with the object's material name.  Then you can transfer the 



material from the previous scene and assign it to the pasted objects in the new scene 
by using Select applied.
<p>
Finding Things

A quick way to find an object in the World Browser list is to type the first letter of the 
object’s name while the list is highlighted. 

Using DXF Files

DXF FILES treat holes in objects differently than Extreme 3D. If you are exporting a 
model with holes to DXF, you may wish to create it with a slight seam connecting the 
inside of the hole to the outside.

DXF HAS difficulties with holes; create the object so that the surface is not actually 
punctured. 

USE SIMPLIFY and edit the object's control  points to optimize the size of file.

Number Of Polygons In A Scene

To find out how many polygons will be rendered in a scene, deselect all objects and 
update both the interactive and final smoothness settings to have the same value. Then 
check the polygon count that appears on the About Box.
<p>
Measuring Spaces And Objects

You can make  rulers using Construction Grids for visual measurement.
The placement tool can snap a grid flush to a surface. Opening the geometry of a grid 
and pulling control points will size it to fit any object.

Preferences

-- Cap Ends
You may want to leave this preference on as you can change your mind later and 
remove any inadvertent end caps using Separate End caps.

-- Nudge Position

When you are doing repeated duplication operations, setting this to a value of one unit 
lets you quickly  realign a duplicate with the original.
<p>
Importing 3D Scripts And Extreme 3D Tracks

See Dynamic Animation under ANIMATION TIPS.

Importing MacroModel Models 



After  importing MacroModel models, choose Select All from the Edit menu and then 
choose Render Style from the Object menu to change the rendering style of all objects 
from smooth to shader. This fixes the interactive rendering bug that manifests itself 
when displaying MacroModel  models that are saved with the Gouraud shading mode.
<p>


